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ABSTRAK 

PT. Kereta Api Indonesia Balai Yasa Surabaya Gubeng membutuhkan 

prototype yang dapat digunakan sebagai monitoring suhu pada ruangan server 

melalui smartphone Android. Menggunakan mikrokontroler dan juga aplikasi pada 

Android yang saling terintegrasi diantara keduanya sehingga dapat memantau suhu 

ruangan pada server PT. Kereta Api Indonesia.   

Projek ini bertujuan untuk mempermudah pengguna untuk memantau suhu 

secara jarak jauh, tak hanya mempermudah pengguna namun juga dapat 

menghemat efisiensi waktu dengan menggunakan gadget mereka yaitu smartphone 

tentunya dengan menggunakan jaringan internet. Modul esp8266 yang dikemas 

sebagai mikrokontroler digunakan sebagai media transmisi data tersebut yaitu 

wemos yang diintegrasikan dengan database Firebase. Sensor suhu LM35 sebagai 

media untuk membaca keadaan suhu pada ruang server yang bertempat di PT. 

Kereta Api Indonesia yang kemudian digunakan sebagai monitoring suhu 

menggunakan aplikasi android yang telah disiapkan. Kegunaan dari jaringan 

internet pada projek ini adalah untuk menampilkan data yang diunggah pada 

Firebase ke aplikasi Android sehingga apabila ada data baru yang tersimpan ke 

dalam Firebase maka akan muncul data baru pada aplikasi Android.  

Hasil dari alat ini yang menunjukkan output suhu yang dihasilkan oleh 

sensor suhu LM35 yang dibandingkan dengan suhu thermometer sebagai 

perbandingan suhu yang valid. Akurasi error yang didapat dari kedua output 

tersebut  

Kata Kunci: Firebase, Wemos, LM35, Android, Realtime 
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BAB I 

PENDAHULUAN 

1.1. Latar Belakang 

Seiring dengan perkembangan zaman, teknologi yang ada sekarang ini telah 

mengalami perkembangan yang sangat pesat, sehingga memudahkan pengguna untuk 

mengoperasikan segala aktivitas yang dilakukannya dengan menggunakan teknologi 

tersebut. Salah satu pengembangan dari teknologi tersebut yaitu Internet of Things 

(IoT). Tak sedikit dari kalangan pengembang dan para peneliti memanfaatkan 

teknologi tersebut, dikarenakan teknologi ini sangat memudahkan para penggunanya 

mulai dari aspek penelitian maupun aspek kehidupan sehari – hari yang berkaitan 

dengan teknologi IoT. 

Internet of Things dapat diartikan sebagai benda – benda di sekitar yang dapat 

berkomunikasi antara satu dengan yang lain melalui jaringan internet. Salah satu dari 

pengembangan teknologi Internet of Things tersebut adalah Modul ESP8266 yang 

dikemas dalam mikrokontroler. Dari pengembangan tersebut, banyak dari kalangan 

pengembang dan juga pengguna lain yang ingin mengembangkan suatu projek dengan 

teknologi dari mikrokontroler ini. Pada laporan kerja praktik ini, menggunakan 

mikrokontroler tersebut yang akan digunakan sebagai media transmisi data yaitu 

Wemos dan untuk sensor suhu yang digunakan ialah LM35, sedangkan media 

penerima data tersebut menggunakan aplikasi android yang sudah dirancang untuk 

menerima data dari alat tersebut. Dari kedua media tersebut, digunakanlah sebagai alat 

monitoring suhu. 
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1.2. Rumusan Masalah 

Berdasarkan latar belakang di atas, maka rumusan masalah kerja praktik pada 

PT. Kereta Api Indonesia Balai Yasa Surabaya Gubeng adalah sebagai berikut: 

1. Bagaimana monitoring suhu menggunakan Wemos dan Android ? 

2. Bagaimana mentransmisikan data menggunakan Wemos ? 

 

1.3. Batasan Masalah 

Dari perumusan masalah di atas, maka batasan masalah dalam pembuatan alat 

tersebut adalah sebagai berikut: 

1. Sensor suhu yang digunakan ialah LM35 

2. Pengiriman data menggunakan Wemos 

3. Database yang digunakan adalah Firebase. 
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1.4. Tujuan 

Tujuan dari kerja praktik yang dilaksanakan mahasiswa yaitu agar mahasiswa 

tersebut dapat merasakan bagaimana kondisi di dunia kerja sehingga mendapatkan 

pengalaman di dunia kerja tersebut. Serta tujuan utama dari pelaksanaan kerja praktik 

tersebut yaitu: 

1. Menguji rancangan dari alat monitoring suhu menggunakan Wemos 

2. Menganalisis suhu dari ruang server 

 

1.5. Manfaat 

Manfaat yang diperoleh dari alat ini adalah mempermudah untuk memantau 

atau memonitoring suhu melalui smartphone android yang sudah dipasang aplikasi 

buatan untuk memantau suhu dari alat tersebut.  
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BAB II 

GAMBARAN UMUM PERUSAHAAN  

PT. KERETA API INDONESIA 

2.1. Sejarah Perusahaan  

Kehadiran kereta api di Indonesia ditandai dengan pencangkulan pertama 

pembangunan jalan kereta api di desa Kemijen, Jumat 17 Juni 1864 oleh Gubernur 

Jenderal Hindia Belanda Mr. L.A.J Baron Sloet Van Den Beele. Pembangunan 

diprakarsai oleh “Naamloze venootscahp Nederland Indische Spoorweg Maatschappij” 

(NV. NISM) yang dipimpin oleh Ir. J.P de Bordes dari Kemijen menuju desa Tanggung 

(25 KM) dengan lebar sepur 1435 mm. Ruas jalan ini dibuka untuk angkutan umum 

pada hari Sabtu 10 Agustus 1867. Kolonel Jhr. Van Der Wijk adalah seorang militer 

Belanda yang mana beliau adalah orang pertama yang menggagaskan pembangunan 

jaringan jalan kereta api pertama pada tanggal 15 Agustus 1840, tujuannya agar dapat 

mengangkut hasil bumi serta bermanfaat bagi kepentingan pertahanan pada waktu 

itu.Selain di Jawa, pembangunan jalan kereta api juga dilakukan di Sumatera Selatan 

(1914), Sumatera Barat (1891), Sumatera Utara (1886), Aceh (1874), bahkan tahun 

1922 di Sulawesi juga telah dibangun jalan kereta api sepanjang 47 km antara 

Makassar-Takalar, yang pengoperasiannya dilakukan tanggal 1 Juli 1923, sisanya 

ujung pandang-Maros belum sempat diselesaikan. Sedangkan Kalimantan, meskipun 

belum sempat dibangun, studi jalan kereta api Pontianak-Sambas (220 km) sudah 

diselesaikan. Demikian juga pulau Bali dan Lombok juga pernah dilakukan studi 

pembangunan jalan kereta api. 
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Keberhasilan swasta NV. NISM membangun jalan kerta api antara Kemijen-

Tanggung, yang kemudian pada tanggal 10 Februari 1870 dapat menghubungkan kota 

Semarang-Surakarta (110 KM), akhirnya mendorong minat investor untuk 

membangun jalan kereta api di daerah lainnya. Tidak mengherankan, kalau 

pertumbuhan panjang rel anatara 1864-1900 tumbuh dengan pesat. Kalau tahun 1867 

baru 25 km, tahun 1870 menjadi 110 km, tahun 1880 mencapai 405 km, tahun 1890 

menjadi 1.427 km dan pada thun 1900 menjadi 3.338 km Karena, pemerintah Belanda 

kemudian merasa pentingnya dibangun jaringan rel kereta apai pada banyak tempat, 

sedangkan NISM setelah itu mengalami kesulitan keuangan yang sangat dahsyat, maka 

pemerintah Belanda akhirnya memutuskan untuk mengambil alih pembangunan 

jaringan rel kereta api. Selanjutnya pemerintah Belanda membuka jalur antara Jakarta-

Bandung, Sidoarjo-Madiun-Surakarta, Kertosono-Blitar, Madiun-Surakarta, serta 

Yogyakarta-Cilacap. Akhirnya hampir pada setiap daerah terutama di daerah dekat 

pantai di seluruh Jawa telah dapat memanfaatkan sarana transportasi berupa kereta api, 

bahkan sampai dataran Sumatera dan Sulawesi. Sampai dengan tahun 1939, panjang 

jalan kereta api di Indonesia mencapai 6.881 km. Tetapi, pada tahun 1950 panjangnya 

berkurang menjadi 5.910 km, kurang lebih 901 km raib, yang diperkirakan karena di 

bongkar semasa pendudukan Jepang dan diangkut ke Burma untuk pembangunan jalan 

kerta api di sana. Kesuksesan pembangunan dan pemanfaatan jaringan 

transportasikereta apai yang dirasakan pemerintah kolonial Belanda maupun pihak-

pihak swasta terpaksa berakhir setelah Jepang masuk ke Indonesia. Setelah 

pemerintahan Belanda menyerah tanpa syarat kepada Jepang pada tahun 1942, sejak 

saat itulah saranasarana yang telah dibbangun oleh pemerintah Belanda juga dikuasai 
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oleh Jepang termasuk sarana dan jaringan rel kereta api. Jenis rel kereta api di Indonesia 

dibedakan dengan lebar sepur 1.067 mm; 750 mm di Aceh dan 600 mm di beberapa 

lintas cabang dan tram kota. Jalan rel yang di bongkar semasa pendudukan Jepang 

(1942-1943) sepanjang 437 km. Sedangkan jalan kereta api yang dibangun semasa 

pendudukan Jepang adalah 83 km anatara Bayah-Cikara dan 220 km antara Muaro-

Pekanbaru diprogramkan selesai pembangunana selama 15 bulan yang 

memperkerjakan 27.500 orang, 25.000 siantaranya adalah Romusha. Jalan yang 

melintasi rawa-rawa, perbukitan, serta suangi yang deras arusnya ini, banyak menelan 

korban yang makamnya bertebaran sepanjang Muaro-Pekanbaru.  

Jepang mempekerjakan orang-orang pribumi pada dinas kereta api bahkan ada 

yang menduduki jabatan tingkat menengah. Selain mengadakan penerimaan pegawai 

secara besar-besaran pada tahun 1942-1943, pemerintah Jepang juga menyelenggrakan 

semacam sekolah tinggi perkeretaapian dengan nama “Kyo Syu Syo” yang bertempat 

di Bandung. Berkat sekolah perkeretaapian tersebut, orang-orang Indonesia kemudian 

banyak menguasasi berbagai hal yang berhubungan dengan kereta api. Bahkan, 

menjelang berakhirnya kekuasaan pemerintah Jepan, pegawai kereta api yang 

merupakan orang-orang Indonesia berjumlah kurang lebih 80.000 orang yang 

mayoritas sebagi pegawai rendah. Memasuki tahun 1945 barulah beberapa pegawai 

diangkat sebagai wakil jabatan tertentu mendampingi orang Jepang. 

Setelah kemerdekaan Indonesia diproklamirkan pada tanggal 17 Agustus 1945, 

karyawan kereta api yang tergabung dalam “Angkatan Moeda Kereta Api” (AMKA) 

mengambil alih kekuasaan perkeretaapian dari pihak Jepang. Peristiwa bersejarah yang 

terjadipada tanggal 28 September 1945, pembacaan sikap oleh Ismangil dan sejumlah 
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AMKA lainnya, menegaskan bahwa mulai tanggal 28 Spetember 1928 kekuasaan 

perkereta apian berada ditangan bangsa Indonesia. Orang Jepang tidak diperkenankan 

lagi ikut campur tangan dengan urusan perkeretaapian di Indonesia. Inilah yang 

melandasi titetapkannya 28 Spetember 1945 sebagai hari Kereta Api Indonesia, serta 

dibentuknya “Djawatan Kereta Api Republik Indonesia” (DKARI). Meskipun DKARI 

telah terbentuk, namun tidak semua perusahaan kereta api menyatu. Sedikitnya ada 11 

perusahaan kereta apai swasta di Jawa dan satu swasta (Deli Spoorweg Maatschapij) 

di Sumatera Utara yang masih terpisah dengan DKARI. Lima tahun kemudian, 

berdasarkan Pengumuman Menteri Perhubungan, Tenaga, dan Pekerjaan Umum No. 2 

Tanggal 6 Januari 1950, ditetapkan bahwa 1 Januarai 1950 DKARI dan “Staat-spoor 

Wegen en Verenigde Spoorweg Bedrijf ” (SS/VS) digabung menjadi satu perusahaan 

kereta api yang bernama “Djawatan Kereta Api” (DKA). 

Dalam rangka pembenahan badan usaha, pemerintah mengeluarkan UU No. 19 

Tahun 1960, yang menetapkan usaha BUMN. Atas dasar UU ini, dengan Peraturan 

Pemerintah No. 22 Tahun 1963, tanggal 25 Mei 1963 di bentuk “Perusahaan Negara 

Kereta Api” (PNKA), sehingga Djawatan Kereta Api di ebur kedalamnya. Sejak itu, 

semua perusahaan kereta api di Indonesia terkena “integrasi” ke dalam satu wadah 

PNKA, termasuk kereta apai di Sumatera Utara yang sebelumnya dikelola oleh DSM. 

Masih dalam rangka pembenahan BUMN, pemerintah mengeluarkan UU No. 

9 Tahun 1969 tanggal 1 Agustus 1969, yang menetapkan jenis BUMN menjadi tiga, 

yaitu Perseroan, Perusahaan Umum, dan Perusahaan Jawatan. Sejalan dengan UU yang 

dimaksud berdasarkan Peraturan Pemerintahan No. 61 Tahun 1971 tanggal 15 
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September 1971, bentuk perusahaan PNKA mengalami perubahan menjadi 

“Perusahaan Jawatan Kereta Api”( PJKA).  

Selanjutnya berdasarkan Peraturan Pemerintahan No.57 Tahun 1990, pada 

tanggal 2 Januari 1991, PJKA menagalami perubahan menjadi Perusahaan Umum 

Kereta Api disingkat Perumka. Sejalan dengan perubahan status ini, kinerja 

perkeretaapian di Indonesia kian membaik. Kalau pada tahun 1990 PJKA rugi 

sebanyak Rp. 32,716 Milyar. Tahun kedua turun menjadi Rp. 2,536 Milyar, tahun ke 

tiga Rp. 1,098 Milyar dan untuk pertama kalinya dalam sejarah perkeretaapian 

Indonesia meraih laba sebesar Rp. 13 juta pada tahun 1993.  

Berikutnya, dalam rangka “Loan Agreement” no. 4106-IND tanggal 15 Januari 

1997 berupa bantuan proyek dari Bank Dunia, yang kemudian lebih dikenal dengan 

Proyek Efisiensi perkeretaapian atau “Railway Efficiency Project” (REP), diarahkan 

pada peningkatan efisiensi dan kualitas pelayanan yang ditempuh melalui delapan 

kebijakan, yaitu : 

A. Memperjelas peranan antara pemilik (owner), pengaturan (regulator), dan 

pengelola (operator).  

B. Melakukan restrukturisasi Perumka, termasuk merubah status Perusahaan 

Umum menjadi Perseroan Terbatas. 

C. Kebijakan pentarifan dengan pemberian kompensasi dari pemerintah 

kepada Perumka atas penyediaan KA non komersial, yaitu tarifnya 

ditetapkan oleh pemerintah; d) Rencana jangka panjang dituangkan dalam 

Perencanaan Perusahaan (Corpoorate Planning), yang dijabarkan ke dalam 

rencana kerja anggaran perusahaan secara tahunan. 



9 

 

 

 

D. Penggunaan peraturan dan prosedur dalam setiap kegiatan. 

E. Pengingkatan peran serta sektor swasta. 

F. Peningkatan SDM 

Sejalan dengan maksud REP tersebut, dengan Peraturan Pemerintahan No.19 

Tahun 1998, pada tanggal 3 Februari 1998, pemerintah menetapkan pengalihan bentuk 

Perusahaan Umum (PERUM) Kereta Api menjadi Perusahaan Perseroan (Persero). 

Proses perubahan status perusahaan dari Perum menjadi Persero secara “de-facto” 

dilakukan tanggal 1 Juli 1999, saat Menhub Giri .S. Hadiharjono mengukuhkan 

susunan Direksi PT Kereta Api (Persero) di Bandung. 
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2.2. Logo Perusahaan 

  

 

2.3. Visi, Misi dan Moto Perusahaan 

Berdasarkan hasil rapat Direksi PT Kereta Api (Persero), merubah visi dan misi 

yang lama menjadi visi dan misi yang baru, yakni Maklumat Direksi Nomor : 

No.14/PR.006/KA.2009 menyebutkan bahwa, sejalannya dengan Arah dan Startegi 

Pengembangan (Restrukturisasi) Perusahaan, maka sesuai Kesepakatan pada tanggal 

29 Mei 2009 di Bandung, Direksi PT. KERETA API (Persero) telah menetapkan VISI 

dan MISI perusahaan yang baru.  
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2.3.1. Visi PT. Kereta Api (Persero) 

Visi PT. Kereta Api (Persero) Indonesia yaitu Menjadi penyedia jasa 

perkeretaapian terbaik yang fokus pada pelayanan pelanggan dan memenuhi harapan 

stakeholders. 

 

2.3.2. Misi PT. Kereta Api (Persero) 

Misi yang diemban oleh PT. Kereta Api (Persero) Indonesia yaitu 

Menyelenggarakan bisnis perkeretaapian dan bisnis usaha penunjangnya,melalui 

praktek bisnis dan model organisasi terbaik untuk memberikan nilai tambah yang 

tinggi bagi stakeholders dan kelestarian lingkungan berdasarkan 4 pilar utama : 

keselamatan, ketepatan waktu, pelayanan dan kenyamanan. 

  

2.3.3. Tujuan PT. Kereta Api (Persero) 

Tujuan perusahaan adalah untuk turut serta melaksanakan dan menunjang 

kebijaksanaan dan Program Pemerintah di bidang ekonomi dan pembangunan 

nasioanal khususnya di bidang transportasi, dengan menyediakan barang dan jasa 

bermutu tinggi dan berdaya saing kuat di pasar dalam negeri ataupun internasional di 

bidang perkeretaapian yang meliputi usahapengankutan orang dan barang dengan 

kereta api, kegiatan perawatan prasarana perkeretaapian, pengusahaan prasarana 

perkeretaapian, pengusahaan usaha penunjang prasarana dan sarana kereta api dan 

kemanfaatan umum dengan menetapkan prinsip-prinsip Perseroan Terbatas. 
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2.4. Struktur Oragnisasi 
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BAB III 

LANDASAN TEORI 

3.1. Android 

3.1.1. Definisi Android 

Android adalah platform open source yang bersifat luas dan dirancang untuk 

perangkat mobile atau biasa dikenal dengan smartphone. Dikatakan bersifat luas 

karena Android menyediakan semua tools dan frameworks yang lengkap untuk 

pengembangan aplikasi pada suatu perangkat mobile. (Silvia & Haritman, 2014). 

Menggunakan sistem operasi berbasis Linux bagi perangkat mobile (smartphone) dan 

juga pada komputer tablet. 

 

3.1.2. Sejarah Android 

Android, Inc. didirikan di Palo Alto, California, pada bulan Oktober 2003 oleh 

Andy Rubin (pendiri Danger), Rich Miner (pendiri Wildfire Communications, Inc.), 

Nick Sears (mantan VP T-Mobile), dan Chris White (kepala desain dan 

pengembangan antarmuka WebTV) untuk mengembangkan “perangkat seluler pintar 

yang lebih sadar akan lokasi dan preferensi penggunanya”. Tujuan awal 

pengembangan Android adalah untuk mengembangkan sebuah sistem operasi 

canggih yang diperuntukkan bagi kamera digital, namun kemudian disadari bahwa 

pasar untuk perangkat tersebut tidak cukup besar, dan pengembangan Android lalu 

dialihkan bagi pasar telepon pintar untuk menyaingi Symbian dan Windows Mobile 

(iPhone Apple belum dirilis pada saat itu). Meskipun para pengembang Android 
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adalah pakar-pakar teknologi yang berpengalaman, Android Inc. dioperasikan secara 

diam-diam, hanya diungkapkan bahwa para pengembang sedang menciptakan sebuah 

perangkat lunak yang diperuntukkan bagi telepon seluler. Masih pada tahun yang 

sama, Rubin kehabisan uang. Steve Perlman, seorang teman dekat Rubin, 

meminjaminya $10.000 tunai dan menolak tawaran saham di perusahaan. 

Awalnya Google Inc membeli android Inc yang merupakan pendatang baru 

yang membuat piranti lunak untuk ponsel smartphone. Kemudian pada 

pengembangan Android, dibentuklah Open Handset Alliance, konsorium dari 34 

perusahaan piranti keras, piranti lunak, dan telekomunikasi. Termasuk Google, HTC, 

Intel, Motorola, Qualcomm, T-Mobile dan Nvidia. Pada saat perilisan perdana 

Android, 5 November 2007, Android bersama Open Handset Alliance menyatakan 

mendukung pengembangan open source yang ada pada perangkat mobile. Di satu sisi, 

Google merilis kode – kode Android di bawah lisensi Apache, yang dimana Apache 

adalah lisensi perangkat lunak dan open platform perangkat seluler. Pada 9 Desember 

2008, diumumkannya anggota baru yang bergabung pada program kerja Android 

ARM Holdings, Atheros Communications yang diproduksi oleh Asustek Computer 

Inc, Garmin Ltd, Softbank, Sony Ericsson, Toshiba Corp dan Vodafone Group Plc 

(Masruri & Java, 2015) 

Pada tahun 2010, Google merilis seri Nexus; perangkat telepon pintar dan 

tablet dengan sistem operasi Android yang diproduksi oleh mitra produsen telepon 

seluler seperti HTC, LG, dan Samsung. HTC bekerjasama dengan Google dalam 

merilis produk telepon pintar Nexus pertama, yakni Nexus One. Seri ini telah 

diperbarui dengan perangkat yang lebih baru, misalnya telepon pintar Nexus 4 dan 
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tablet Nexus 10 yang diproduksi oleh LG dan Samsung. Pada 15 Oktober 2014, 

Google mengumumkan Nexus 6 dan Nexus 9 yang diproduksi oleh Motorola dan 

HTC. Pada 13 Maret 2013, Larry Page mengumumkan dalam postingan blognya 

bahwa Andy Rubin telah pindah dari divisi Android untuk mengerjakan proyek-

proyek baru di Google. Ia digantikan oleh Sundar Pichai, yang sebelumnya menjabat 

sebagai kepala divisi Google Chrome, yang mengembangkan Chrome OS. 

Sejak tahun 2008, Android secara bertahap telah melakukan sejumlah 

pembaruan untuk meningkatkan kinerja sistem operasi, menambahkan fitur baru, dan 

memperbaiki bug yang terdapat pada versi sebelumnya. Setiap versi utama yang 

dirilis dinamakan secara alfabetis berdasarkan nama-nama makanan pencuci mulut 

atau cemilan bergula; misalnya, versi 1.5 bernama Cupcake, yang kemudian diikuti 

oleh versi 1.6 Donut. Versi terbaru adalah 5.0 Lollipop, yang dirilis pada 15 Oktober 

2014. 

 

3.2. Firebase 

Firebase adalah suatu layanan dari Google yang biasa digunakan oleh para 

pengembang aplikasi dan memudahkan untuk mengembangkan aplikasi. Dengan 

adanya Firebase ini para pengembang dapat memfokuskan pengembangan aplikasinya 

tanpa harus mengeluarkan usaha yang besar. 
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3.2.1. Firebase Authentication 

Sebagian besar aplikasi tentu membutuhkan autentikasi untuk mengetahui 

identitas pengguna. Mengetahui sebuah identitas dari pengguna memungkinkan 

aplikasi untuk secara aman menyimpan data pengguna di cloud dan memberikan 

pengalaman pribadi yang sama di semua perangkat pengguna. Firebase menyediakan 

layanan backend, SDK yang mudah digunakan dan pustaka siap pakai untuk 

mengautentikasi pengguna ke aplikasi. Saat ini Firebase mendukung autentikasi 

menggunakan sandi, sosial media popular seperti Google, Facebook, Twitter dan 

lainnya (Ilham, 2017). Autentikasi yang digunakan pada aplikasi ini menggunakan 

email dan password yang sudah tertanam pada Firebase Authentication, sehingga 

ketika membuka aplikasi tersebut akan langsung masuk pada menu utama. 

Gambar 3.1. Metode login Firebase Authentication 
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3.2.2. Firebase Realtime Database 

Firebase Realtime Database merupakan cloud database. Data yang disimpan 

tersebut berupa format JSON dan disinkronkan secara realtime ke setiap client yang 

terhubung. Firebase Realtime Database adalah basis data MySQL dikarenakan 

memiliki optimalisasi dan fungsi yang berbeda dibandingkan basis data relasional. 

Membuat database Firebase bisa melalui import file JSON ke konsol Firebase atau 

bisa juga secara manual yaitu dibuat langsung melalui halaman konsol Realtime 

Database. 

 

3.3. Sensor Suhu LM35 

LM35 adalah sebuah komponen eletronika yang memiliki fungsi merubah 

besaran suhu menjadi besaran tegangan. LM35 memiliki keakuratan yang tinggi dan 

juga perancangannya yang mudah jika dibandingkan sensor suhu yang lainnya, LM35 

juga memiliki keluaran impedansi yang rendah dan linearitas tinggi, sehingga dapat 

dengan mudah dihubungkan pada rangkaian kendali khusus. Sensor suhu LM35 

membutuhkan sumber tegangan DC +5 volt dan konsumsi arus DC sebesar 60 µA 

dalam beroperasi (Elektronika Dasar, 2016).  

Sensor suhu IC LM35 memiliki keakuratan tinggi dan mudah dalam 

perancangan jika dibandingkan dengan sensor suhu yang lain, sensor suhu LM35 juga 

mempunyai keluaran impedansi yang rendah dan linieritas yang tinggi sehingga dapat 

dengan mudah dihubungkan dengan rangkaian kontrol khusus serta tidak memerlukan 

seting tambahan karena output dari sensor suhu LM35 memiliki karakter yang linier 
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dengan perubahan 10mV/°C. Pada umumya bentuk dari sensor suhu LM35 seperti 

yang terlihat pada gambar dibawah : 

 

 

 

 

 

  Gambar 3.2. Sensor suhu LM35 

Karakteristik Sensor suhu IC LM35 adalah : 

 Memiliki sensitivitas suhu, dengan faktor skala linier antara tegangan dan 

suhu 10 mVolt/ºC, sehingga dapat dikalibrasi langsung dalam celcius. 

 Memiliki ketepatan atau akurasi kalibrasi yaitu 0,5ºC pada suhu 25 ºC 

seperti terlihat pada gambar diatas. 

 Memiliki jangkauan maksimal operasi suhu antara -55 ºC sampai +150 ºC. 

 Bekerja pada tegangan 4 sampai 30 volt. 

 Memiliki arus rendah yaitu kurang dari 60 µA. 

 Memiliki pemanasan sendiri yang rendah (low-heating) yaitu kurang dari 

0,1 ºC pada udara diam. 

 Memiliki impedansi keluaran yang rendah yaitu 0,1 W untuk beban 1 mA. 

 Memiliki ketidaklinieran hanya sekitar ± ¼ ºC. 
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Sensor suhu LM35 memiliki jangkauan pengukuran -55ºC hingga +150ºC 

dengan akurasi ±0.5ºC. Tegangan output sensor suhu IC LM35 dapat diformulasikan 

sebagai berikut : 

Vout LM35 = Temperature º x 10 mV 

Kelebihan dari sensor suhu IC LM35 antara lain : 

 Rentang suhu yang jauh, antara -55 sampai +150ºC. 

 Low self-heating, sebesar 0.08 ºC. 

 Beroperasi pada tegangan 4 sampai 30 V. 

 Rangkaian menjadi sederhana. 

 Tidak memerlukan pengkodisian sinyal. 
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3.4. Wemos D1 Mini 

Wemos adalah sebuah board development system yang memiliki WiFi berbasis 

ESP-8266 yang memudahkan dalam pengembangan perangkat IoT dan juga bersifat 

open source. Wemos juga dapat dikombinasikan mikrokontroler lainnya seperti 

Arduino maupun Nodemcu sehingga memiliki kemampuan yang baik. Berikut adalah 

spesifikasi dari Wemos D1 mini: 

a. Beroperasi pada tegangan 3.3V 

b. Memiliki 11 pin digital I/O  

c. WiFi Modul ESP-8266 

d. 1 Pin analog input (3.2V input maksimal) 

e. Port micro USB 

f. Clock speed 80MHz/160MHz 

g. Flash memori sebesar 4MB 

h. Panjang 34.2mm dan Lebar 25.6mm 

i. Berat sebesar 3gram 

 

 

 

 

 

 

 

Gambar 3.3. Wemos D1 mini 
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Berdasarkan spesifikasi di atas, maka Wemos memiliki keunggulan sebagai 

mikrokontroler yang dipilih sebagai alat dari projek yang akan dibuat. Keunggulan 

yang terdapat pada Wemos dibandingkan Arduino Uno yakni adanya modul ESP-8266 

yang terdapat pada board dari Wemos. Dengan adanya modul WiFi tersebut akan 

memudahkan Wemos untuk berkomunikasi dengan perangkat lain. Wemos juga 

memiliki flash memory sebesar 4MB jika dibandingkan Arduino Uno yang hanya 

memiliki flash memory sebesar 32KB tentu Wemos memiliki flash memory yang 

sangat besar. Flash Memory tersebut digunakan sebagai media penyimpanan pada 

mikrokontroler, kode – kode yang dituliskan oleh user akan disimpan pada flash 

memory. Wemos juga memiliki clock speed sebesar 80 atau 160MHz yang artinya 

semakin kecil ukuran clock speed maka komputasi yang dilakukan oleh mikrokontroler 

akan semakin rendah akan tetapi penggunaan dayanya kecil sedangkan semakin besar 

ukuran clock speed maka komputasi akan semakin besar dan juga membutuhkan daya 

yang lebih besar juga. Sumber daya dari Wemos D1 mini ialah menggunakan micro 

usb. (Supegina & Setiawan, 2017) 
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BAB IV 

HASIL KERJA PRAKTIK 

 Pada bab ini akan membahas proses pembuatan dan implementasi dari alat 

yang telah dikerjakan.  

4.1. Diagram Blok 

 

Gambar 4.1. Blok diagram 

Dari diagram alur diatas, dapat dijelaskan bahwa data yang di hasilkan oleh 

sensor suhu LM35 akan di proses oleh Wemos dan kemudian data tersebut akan di 

upload ke database firebase sehingga pada aplikasi android dapat membaca data suhu 

dari LM35 yang telah diproses oleh Wemos tersebut. 

 

WEMOS LM35 

FIREBASE ANDROID 
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4.2. Skematik Rangkaian 

 

 

 

 

 

 

 

 

 

 

Gambar 4.2. Rangkaian Skematik Alat 

Gambar di atas merupakan rangkaian skematik dari alat monitoring suhu yang 

akan digunakan pada ruang server PT. Kereta Api Indonesia dengan menggunakan 

Wemos dan LM35. Koneksi dari alat ini menggunakan kabel yang dimana kabel 

tersebut akan dihubungkan pada pin yang berada di Wemos. Berikut pin Wemos yang 

terhubung dengan LM35 : 

1) Kaki tengah LM35 terhubung dengan pin A0 (Analog 0) pada Wemos 

2) Kaki kiri LM35 terhubung dengan pin Vcc 5V pada Wemos 

3) Kaki kanan LM35 terhubung dengan pin ground pada Wemos  
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4.3. Cara Menggunakan Wemos 

Wemos merupakan salah satu arduino compatible development board yang 

dirancang khusus untuk keperluan IoT (Internet of Thing). Wemos menggunakan chip 

WiFi yang cukup terkenal yaitu ESP8266.  

1) Download Arduino IDE. 

2) Hubungkan board anda dan tunggu Windows untuk memulai proses instalasi 

driver. 

3) Jalankan Aplikasi Arduino. 

 

 

 

 

 

 

 

  

  

  

  

  

Gambar 4.3. Tampilan awal Arduino IDE 



25 

 

 

 

4) Klik tab File > Preferences.  

  

 

 

 

 

 

 

 

 

 

 

Gambar 4.4. Tab File 
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5) Kemudian salin url yang terdapat pada gambar 4.5. yang diberi kotak hitam 

untuk download board dari Wemos tersebut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.5. Tab Preferences 
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6) Langkah selanjutnya adalah men – download board Wemos tersebut, dengan 

cara klik Tools > Board > Boards Manager. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.6. Langkah membuka Boards Manager 
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7) Klik bagian search engine yang ada pada window dari boards manager 

kemudian ketik esp8266 maka keluarlah tampilan seperti pada gambar 4.7. di 

bawah ini. Lalu pilih versi yang terbaru kemudian klik install.  

 

 

 

 

 

 

 

Gambar 4.7. Boards Manager 

Pada menu boards manager yaitu berfungsi sebagai instalasi board yang sesuai 

dengan mikrokontroler yang digunakan oleh pengguna dengan cara ketikkan keyword 

pada search engine kemudian download board tersebut.  
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8) Pilih board arduino anda, pada menu Tools > Board sesuai arduino anda. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.8. Langkah untuk memilih board Wemos 
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9) Pilih serial port arduino anda, pada menu Tools > serial port pada Arduino 

anda. 

 

 

 

 

 

 

 

 

 

 

Gambar 4.9. Pemilihan port yang akan digunakan 
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4.4. Konfigurasi Android 

Berikut langkah – langkah konfigurasi Android untuk menghubungkan 

perangkat Android dengan Wemos : 

1) Buka aplikasi suhu pada Android yang sudah di-install pada smartphone. 

2) Pastikan smartphone dari pengguna terhubung pada jaringan internet. 

3) Apabila aplikasi tersebut sudah terbuka, anda akan dihadapkan pada tampilan 

seperti gambar 4.10. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.10. Tampilan aplikasi monitoring suhu 
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4) Apabila pengguna mengklik tombol next yang berada pada bawah kanan dari 

tampilan utama tersebut, maka pengguna akan menemui halaman kedua dari 

aplikasi tersebut yang berisikan tentang data grafik. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.11. Tampilan grafik 
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4.5. Flowchart Wemos ke Firebase 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.12. Flowchart koneksi ke Firebase (1) 

 

 

Start 
static char 

suhuku [20]; 

int  

analogV = 0; 

float mVolt = 0; 

float temp = 0; 
WiFi.begin(WIFI_SSID, 

WIFI_PASSWORD); 

Serial.print 

("Connecting"); 

While(WiFi.status()!= 

WL_CONNECTED) 

Serial.print("."); 

Serial.println(); 

Serial.print("Connected: "); 

Serial.println(WiFi.localIP()); 

A 
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Gambar 4.13. Flowchart koneksi ke Firebase (2) 

 

 

 

 

 

 

 

 

A 

Firebase.begin 

(FIREBASE_HOST, 

FIREBASE_AUTH); 

analogV = analogRead(A0); 

mVolt = (analogV / 1024.0) * 

3300; 

temp = mVolt / 10; 

dtostrf(temp, 5, 2, suhuku); 

DynamicJsonBuffer 

jsonBuffer; 

JsonObject& 

temperatureObject

=jsonBuffer.create

Object(); 

JsonObject&tempTi

me=temperatureObj

ect.createNestedObj

ect("timestamp"); 

temperatureObject["value"] 

=suhuku; 

tempTime[".sv"] ="timestamp" 

End 
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4.6. Cara komunikasi Firebase dengan Android 

Berikut adalah cara komunikasi Firebase dengan Android dengan tujuan untuk 

mengambil data suhu yang terdapat di firebase untuk ditampilkan pada aplikasi 

Android. 

1) Langkah pertama 

Gambar 4.14. Source code MainActivity.java 

Gambar di atas menunjukkan sebuah langkah awal yaitu autentikasi pada 

Firebase dengan menggunakan email dan password yang telah dicantumkan pada 

Firebase Authentication. Penjelasan pada gambar diatas yaitu jika user itu null atau 

belum pernah login, maka akan berpindah ke activity selanjutnya yaitu StartActivity 

dan apabila sudah pernah login maka akan berpindah pada slide Home. 
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2) Langkah kedua 

Gambar 4.15. Source code StartActivity.java 

Berikut adalah langkah kedua dari Firebase Authentication setelah cek 

autentikasi dari langkah pertama tersebut apabila belom pernah login kemudian 

berpindah ke StartActivity yang dimana pada slide ini adalah syarat untuk autentikasi 

menggunakan email dan password seperti yang terlihat pada gambar di atas dengan 

menggunakan email yang telah terdaftar dan sesuai dengan yang telah didaftarkan pada 

Firebase Authentication dan yang akan digunakan pada Android yaitu dengan email 

(wimar@gmail.com), password (wimar123). Jika login tersebut sukses maka slide 

tersebut akan berpindah ke slide Home dan apabila login tersebut gagal maka akan 

keluar peringatan “Can’t sign in. Please check the form and try again”. 

 

mailto:wimar@gmail.com
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3) Langkah Ketiga 

Gambar 4.16. Source code Home.java 

Pada langkah ketiga ini yaitu langkah setelah autentikasi dengan cara login 

email dan password. Tujuan dari autentikasi tersebut adalah supaya data yang ada pada 

Firebase Database dapat ditampilkan pada aplikasi Android yang berupa nilai dari 

suhu yang berada di ruang server PT. KAI. Apabila user ingin meng – klik tombol next 

maka akan berpindah ke halaman selanjutnya yaitu tampilan grafik seperti pada gambar 

4.11. yang dimana menampilkan data yang ada pada Firebase Database. 
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4.7. Hasil Pengujian 

1) Tabel pengujian hari pertama, tanggal 18 September 2018 

Jam  Sensor Suhu (°C) Suhu Server (°C) Error (%) 

14.30 25,71 25,3 1,6 

14.31 25,81 25,3 1,98 

14.32 25,61 25,3 1,21 

14.33 26 25,4 2,31 

14.34 26,07 25,9 0,65 

14.35 24,61 25,7 4,43 

14.36 24,9 25,7 3,21 

14.37 25,82 25,8 0,08 

14.38 26,03 26,2 0,65 

14.39 25,78 25,8 0,08 

14.40 24,61 25,9 5,24 

14.41 26,07 25,9 0,65 

14.42 26,07 25,9 0,65 

14.43 26 25,8 0,77 

14.44 26 25,8 0,77 

14.45 26 26 0 

14.46 25,54 25,9 1,41 

14.47 26,37 26 1,4 

14.48 26,07 26 0,27 

14.49 26,37 26,1 1,02 

14.50 26,07 26,1 0,11 

14.51 26,07 26 0,27 

14.52 26,07 26,2 0,5 

14.53 26,07 26,1 0,11 

14.54 26,07 25,9 0,65 

14.55 26,07 26,1 0,11 

14.56 26,07 26 0,27 

14.57 26,07 26,2 0,5 

14.58 26,07 26 0,27 
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Jam  Sensor Suhu (°C) Suhu Server (°C) Error (%) 

15.00 26,07 26,1 0,11 

15.01 26,07 25,9 0,65 

15.02 26,06 26 0,23 

15.03 26,07 25,9 0,65 

15.04 26,07 25,9 0,65 

15.05 26,07 26 0,27 

15.06 26,07 26,9 3,18 

15.07 25,78 25,6 0,7 

15.08 25,78 25,7 0,31 

15.09 25,78 25,7 0,31 

15.1 25,78 25,6 0,7 

15.11 25,78 25,6 0,7 

15.12 25,78 25,7 0,31 

15.13 25,78 25,7 0,31 

15.14 25,78 25,6 0,7 

15.15 25,78 26,6 3,18 

15.16 25,78 25,7 0,31 

15.17 25,78 25,8 0,08 

15.18 25,78 25,2 2,3 

15.19 25,78 25,2 2,3 

15.20 25,78 25,8 0,08 

15.21 25,78 25,7 0,31 

15.22 25,78 25,1 2,64 

15.23 26,07 26,1 0,12 

15.24 25,78 26,1 1,24 

15.25 25,78 25,9 0,47 

15.26 25,78 25,9 0,47 

15.27 25,78 25,7 0,31 

15.28 25,78 25,6 0,7 

15.29 25,78 25,6 0,7 

Total 51,49 50,9 56,43 

Tabel 4.1. Hasil pengujian hari pertama 
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2) Data grafik hari pertama 

 

 

Gambar 4.17. Data grafik hari pertama 

 Terlihat dari grafik di atas tersebut, bahwa pada hari pertama suhu di ruangan 

server PT. KAI berkisar antara 25°C – 26°C.  
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3) Tabel pengujian hari ke dua, tanggal 19 September 2018  

Jam Suhu (°C) Suhu Server (°C) Error (%) 

14.30 26,37 25,3 4,06 

14.31 26,37 25,3 4,06 

14.32 26,37 25,3 4,06 

14.33 26,37 25,4 3,70 

14.34 26,37 25,9 1,78 

14.35 26,37 25,7 2,54 

14.36 26,37 25,7 2,54 

14.37 26,37 25,8 2,16 

14.38 26,37 26,2 0,64 

14.39 25,2 25,8 2,38 

14.40 25,2 25,9 2,78 

14.41 25,2 25,9 2,78 

14.42 25,2 25,9 2,78 

14.43 25,2 25,8 2,38 

14.44 25,2 25,8 2,38 

14.45 25,2 26 3,17 

14.46 25,2 25,9 2,78 

14.47 25,2 26 3,17 

14.48 25,2 26 3,17 

14.49 26,66 26,1 2,1 

14.50 26,66 26,1 2,1 

14.51 26,66 26 2,48 

14.52 26,66 26,2 1,72 

14.53 25,2 26,1 3,57 

14.54 25,2 25,9 2,78 

14.55 25,2 26,1 3,57 

14.56 25,2 26 3,17 

14.57 25,2 26,2 3,97 

14.58 25,2 26 3,17 

14.59 25,2 26 3,17 

15.00 26,37 26,1 1,02 

15.01 26,37 25,9 1,78 
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Tabel 4.2. Tabel pengujian hari kedua 

 

 

 

Jam  Sensor Suhu (°C) Suhu Server (°C) Error (%) 

15.02 26,37 26 1,4 

15.03 26,37 25,9 1,78 

15.04 26,37 25,9 1,78 

15.05 26,37 26 1,4 

15.06 26,37 26,9 2,01 

15.07 26,37 25,6 2,92 

15.08 26,37 25,7 2,54 

15.09 26,37 25,7 2,54 

15.10 26,37 25,6 2,92 

15.11 26,37 25,6 2,92 

15.12 26,37 25,7 2,54 

15.13 26,37 25,7 2,54 

15.14 26,37 25,6 2,92 

15.15 25,2 26,6 5,56 

15.16 25,2 25,7 1,98 

15.17 25,2 25,8 2,38 

15.18 25,2 25,2 0 

15.19 25,2 25,2 0 

15.20 25,2 25,8 2,38 

15.21 25,2 25,7 1,98 

15.22 25,2 25,1 0,4 

15.23 25,2 26,1 3,57 

15.24 25,2 26,1 3,57 

15.25 25,2 25,9 2,78 

15.26 25,2 25,9 2,78 

15.27 25,2 25,7 1,98 

15.28 25,2 25,6 1,6 

15.29 25,2 25,6 1,6 

Total 51,57 50,9 5,8 
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4) Data grafik hari kedua 

 

 

 

 

 

 

 

 

 

 

Gambar 4.18. Data grafik hari kedua 

 Pada hari kedua suhu ruang server PT. KAI tetap berada pada 25°C – 26°C. 

Apabila disimpulkan dari pengambilan data dari hari pertama hingga hari kedua ruang 

server PT. KAI memiliki kestabilan antara 25°C – 26°C. 
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BAB V 

PENUTUP 

5.1 Kesimpulan 

Berikut adalah kesimpulan dari hasil yang telah diperoleh : 

1) Monitoring suhu server PT. KAI dapat dilakukan secara realtime dengan 

menggunakan Wemos, yang terintegrasi langsung dengan database Firebase. 

2) Database Firebase dapat mengakses realtime data suhu yang ditampilkan 

secara grafik pada aplikasi Android secara realtime. 

 

5.2 Saran 

1) Dibutuhkan koneksi internet untuk mendapatkan sebuah data. 

2) Sensor dapat digantikan dengan sensor yang lebih sensitif dalam pembacaan 

suhu. 

3) Dibutuhkan lebih banyak pengambilan data suhu apabila digunakan untuk 

tujuan analisis. 
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